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Getting Started with TINA-TI™

This quick-start user's guide presents an overview of TINA-TI™, a powerful circuit design and simulation
tool. TINA-TI is ideal for designing, testing, and troubleshooting a broad variety of basic and advanced
circuits, including complex architectures, without any node or number of device limitations. This document
is intended to help new TINA-TI users start creating circuit simulations using the fundamental features of
TINA-TI software in the shortest possible time.
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Overview

Texas Instruments has teamed up with DesignSoft, Inc. to provide our customers with TINA-TI, a powerful
circuit simulation tool that is well-suited for simulating analog and switched-mode power supply (SMPS)
circuits. The tool is ideal for helping designers and engineers to develop and test circuit ideas.

Tl selected the TINA™ simulation software over other SPICE-based simulators for its combination of
powerful analysis capabilities, simple and intuitive graphics-based interface, and ease of use, allowing you
to be up and running in minimal time. If you are familiar with another SPICE simulator, adapting to TINA-TI
should be an easy and straighforward transition. Although TINA-TI is a limited version of more powerful
DesignSoft simulation products, it easily handles surprisingly complex circuits.

Texas Instruments does not warrant or support any DesignSoft product. TINA-TI is a software program
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2 Schematic Editor

You can download TINA-TI from the [TNA-TT webpagd, as shown in Figure 7. Alternatively, it is available
through the Tl home page at fyww.fi.coni; enter TINA in the keyword search field to display a summary of
TINA-TI related information. Selecting the first result takes you to the [TINA-TT webpagéd.

i ™ arch Tl.com
R TEXAS INSTRUMENTS Technology for Innovators g

products applications design support buy Contact Us |

TI Home > Semiconductors > Amplifiers and Linear >

SPICE-Based Analog Simulation Program
TINA-TI, Status: ACTIVE

Texas Instruments

(G Description = Support Software Technical Documents
© Features © Available Updates ® order Options
What's Included ® compatibility Issues Related Products
. hoear
Name SPICE-Based
gnalolgt_ Download the TINA-TI software by selecting this option.
imulation
Program
Status ACTIVE

Price (US$) Free

Product Information

@ Description

Figure 1. Downloading TINA-TI

The minimum hardware and software requirements for the currently released TINA-TI version are:
* IBM PC-compatible computer running Microsoft Windows® 98/ME/NT/2000/XP

» Pentium or equivalent processor

* 64MB of RAM

» Hard disk drive with at least 100MB free space

* Mouse

* VGA adapter card and monitor
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Once the software is downloaded to your system, select the program through the Windows Start menu or
click on the TINA-TI icon on your desktop that was created during the installation. The first screen appears

as shown in Figure 3.

& Noname - Schematic Editor

File Edit Insert View Analysis T&M Tools Help
—wlale] e [+ clolrls) ol o= | e =
|+ @] [#] & |l & | k|~ [=lFelae[-~[s]a] | | [ | |

L
=

\Basic A Switches /| Meters ASources 4 Semiconddctors 4Spice Macros /

Top row (Menus):
Commands associated with files, types of analysis,

Second row (Icons):
File operations, text, hide and wiring
feature selection, etc.

test and measurement options, and help.

(i

Third and fourth rows (Icons and Tabs):
Third row icons select component type;
fourth row tabs select component group.

Circuit Workspace

4« | |

[\ Noname /

Figure 2. TINA-TI Schematic Editor Display

shows the schematic editor layout. The empty workspace on the sheet is the design window
where you build the test circuit. Below the Schematic Editor title bar is an operational menu row with
selections such as file operations, analytical operations, test and measurement equipment selection, etc.
Located just below the menu row is a row of icons associated with different file and TINA tasks. The final
row of icons allows you to select a specific component group. These component groups contain basic
passive components, semiconductors, and even sophisticated device macromodels. These groups are
accessed to build the circuit schematic.

Building a Circuit with TINA-TI

To illustrate how easy it is to use TINA-TI, we will build an analog circuit and demonstrate some of the
circuit analysis capabilities.

For this example, a high-output, 1kHz sine wave oscillator circuit is selected. A search through a circuit
application handbook provides a humber of op amp-based designs. We will build and simulate a
Wien-bridge oscillator with amplitude stabilization using the software. A Texas Instruments' DPA743 12V
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Select the Spice Macros tab (see Figure 3, step 1) and then the op amp symbol (step 2) to access the
OPA743 macromodel. When the op amp model list appears, scroll down and click on the OPA743 (step
3). Then click OK. The op amp symbol appears in the circuit workspace. With the mouse, drag the symbol
into position (step 4). It is locked into position on the circuit workspace by clicking the left mouse button.

1

2|8 BF [+ 7[5 o|a|+|[: @ <]
JnEsEelesTeEo] [ T ]

\Basic {Switches {Meters {Sources {Semiconductors )Spice Macros faf—— 1. Select Spice Macros tab

2. Select op amp symbol.

Operational Amplifiers

1

i .
3. Select the desired OPAS47 v :l:>*
op amp from the available list. !

1

Shape: [0 | W Autoselect U1 OPAT7431

Manufacturer: | Texas Instruments v | 123/293 4. Move the symbol around
in the circuit workspace to
the desired location.

[~ Show all components

/ 0K l x Cancel' ? Help 1

Figure 3. Building a Circuit with TINA-TI

Other op amp models may be selected using the Insert->Macro... menu. Additionally, macros and a wide
variety of pre-built analog and SMPS circuits can be accessed through the Insert menu.
(Insert->Macro...TinaTl_7.0->Examples).
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3.1 Adding Passive and Active Components

Component selection is easily accomplished by clicking on a component group from the lower row of tabs:
Basic, Switches, Meters, and so forth. These tabs provide a wide variety of passive components, sources,
meters, relays, semiconductors, and the previously-mentioned circuit macros. Click on the schematic
symbol for a particular component and drag it into position in the circuit workspace. A left mouse button
click locks it into place.

In our example, shown in Eigure 4, we select a resistor from the Basic tab group (step 1 and step 2), then
position it next to the op amp symbol. TINA-TI designates this resistor as R1. The initial value of R1 is
1kQ, but this value can be changed as needed. A double-click with the left mouse button on the R1
symbol produces the associated component table (step 3).

8| B& [ |a]|T|5 oo+ @fo <] 1% Jumper connection

J‘L“(D @M’j‘@ JW\'Lé _“_|m|"_":‘l3n€‘|}'§l"\- %Q)/icon

/@/\S witches AMeters ASources ASemiconductors ASpice irtectos /
R1 - Resistor @ {2. Select desired component.

1. Select Basic tab.

IL
-

Label R1

Parameters [Parameters)

| Resistance [Ohm] 4.7k

Power [\w] 1 O v

Temperature Relative

Temperature [C] 0 O >

Linear temp. coef. [1/C] 0 O -

Quadratic temp. coef. [1/C3] 0 2]
3. Select the component and Exponential temp. coef. [%/C] 0 O nd
drag it into place. Double-click Magimum voltage (V) 100 O
the component to active the it e 7
parametric table.

v 0K | X Cancel | ? Hep |

R1 4.7k

DA

7Jumpers are used to connect
common circuit points without
adding wires.

Figure 4. Active and Passive Component Selection

The resistor value and other component characteristics may be altered by selecting the individual
parameter boxes and changing the respective values. Select the component parameter box and highlight
the value you wish to change. Enter a new value by typing over the value that is shown. In Eigure 4, for
example, the value for R1 has been changed from 1k to 4.7k for this circuit. Once you have finished
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3.2 Arranging and Wiring Components

Once all components are selected and properly positioned, they can be wired together. Each component
has nodes where circuit connections are needed. TINA displays these nodes with a small red x. (The x
looks more like two small lines at the wiring node than the alpha character.) Wiring components to each
other is easily done by placing the mouse pointer over a node connection and holding the left mouse
button down. A wire is drawn as the mouse is moved along the circuit space grid. Release the mouse

button when the wire reaches the intended end connection point. illustrates the TINA-TI software
wiring function.

Eﬂ Wien_bridge_osc - Schematic Editor

File Edit Insert View Analysis T&M Tools Help

(|| mrmm/u ||+ [ e =] Y
(LIS [ZTS]&T & [we] &[4 [~ [ = [F6 e[

= -
Wiring operation is controlledg}Saurces {Semiconductors {Spice Macios /
by either the Insert ->Wiring

menu or the pencil icon.

TkHz Wien-bridge Oscillator
Tina-Tl simulation circuit

Wire components together

. . D2 1N4148
by placing the pointer over
the end node (small red “x”).
D1 1MN4148
+
Kt
1

o il v

Figure 5. Wiring Components Together

The wiring function also may be accessed from the Insert menu, or the icon that looks like a small pencil.
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Even if the ERC is not selected, TINA automatically performs a check at the start of a simulation.

Upon selecting one type of analysis to perform, another window appears that displays different setting
selections that are associated with that particular analysis. Nominal settings are initially provided; these
parameters may be set as needed for the desired output.

Once all of the selections are made, click OK to begin the analysis. The first analysis performed on a
circuit is generally a dc analysis. This test provides a reality check so that normal dc operating conditions
can be verified. The TINA-TI DC Analysis function can be set to calculate nodal voltages, provide a table
of dc voltage and current results, generate a dc sweep of the circuit, or perform a temperature analysis.
The temperature analysis works in combination with the Analysis > Mode > temperature-stepping
selections.

4.1 DC Analysis

Follow these steps (illustrated in Eigure §) to perform a dc analysis.

1. Click on the Analysis menu.

2. Select DC Analysis.

3. Click on Table of DC Results. The Voltages/Currents table appears.

4. Use the mouse pointer as a probe to test the circuit nodes.

The probed node and measured value are displayed in red in the Voltages/Currents table, as shown in

T~
O q.

@! Wien_bridge_osc - Schematic Editor
File Edit Insert View EERE! &M Tools Help

5
slals] olg = || a3 o
_” _—.]-_ | qj q ;‘I:I::t' Eontrol Object r | == | -‘T'-“- |L§M{L’ }l{ | =\ |?¥

—\B asic /(Switches KMeters Set Analysis Parameters... Macros /
e DC Analysis > Calculate nodal voltages

————————  AC Analysis 4 Table of DC results
1kHz \ -
TkHz Wien Transient...

) ] DC Transfer Charactgristic...
Tina-Tl sif Steady State Solver... Temperature Analysis, ..
Fourier Analysis

-t
=

_.I

| Moise Analysis. ..

Options...
/ D1 1N4148
Use the mouse pointer as 218 7k

a probe to test various nodes VP_57 v PN
VP_58 29.3
VP_59 41V
VP_E 10V

BF Voltages/Currents

in the circuit.

1 OPAT43

- VP_B0 -4.1Y
R3 3.4k -
o B v Y
rJ' Sy e e2 2 Cradt b
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4.2 Transient Analysis

Sophisticated ac frequency and time domain simulations may also be performed. Use the Analysis
function to access the different choices. A traditional ac transfer characteristic plot of gain and phase
versus frequency may be selected, as well as transient, Fourier or noise analyses. The example shown in
is a transient analysis performed on the example Wien-bridge oscillator circuit. The simulation
transient analysis result is also shown in Figure 7. It illustrates the Wien-bridge oscillator startup and
steady-state performance. The display in the actual window may be edited with axis labeling, scales,
background grid color, and so forth, all set as desired by the individual user.

Follow these steps (marked in Figure 7) to perform a transient analysis.

1. Click on the Analysis menu.

2. Select Transient.

3. The Transient Analysis dialog box appears. Enter start and end times, and other parameters as

desired.

4. Click OK to run the analysis.

S Wien_bridge_osc - Schematic Editor

File Edit Insert View Analysio Tools Help

Dﬂ- g Dﬁ & ERC...

T Mode...
- q

|+

DC Analysis
AC Analysis
Transient...

Fourier Analysis

Noise Analysis...

m Options...

M. o
Select Control Object [ | = l -"_"" |L3 {L’l }I{ | =N

Eecs Meter: Set Analysis Parameters... Macros 7

Steady State Solver...

Tina-TI SUTUEnon Ccur— |

__I__Hi.@;lm_ﬂ}ﬂ E§J|Gmund E
Al [ LTI TPl

» 500

Voltage (V)

R1 4.7k

U1 OPAT43

v
R4 3.4k
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+
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D2 1N4148
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|
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Figure 7. Additional TINA Analysis Capabilities
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5 Test and Measurement

The TINA-TI software generates post-simulation results in tables and plots, depending on the type of
analysis performed. Additionally, the software can be placed in a pseudo-real-time simulation mode where
virtual instruments can be used to observe the output(s) while the circuit is operating.

For example, shows a virtual oscilloscope that is used to observe the steady-state output of the
Wien-bridge oscillator circuit. In the same way, a virtual signal analyzer can be used together with an
amplifier circuit so that the harmonic performance of a simulation can be observed. To access the virtual
oscilloscope, select T&M (step 1 in Eigure §), and then Oscilloscope (step 2). Place the cursor at the
output of the simulated circuit, and adjust the controls in the virtual oscilloscope dialog box as needed
(step 3).

The T&M selection options also include a virtual ac/dc multimeter, function generator, and an X-Y
recorder. The function generator may be adjusted in combination with a virtual oscilloscope or analyzer.

Wien_bridge_osc - Schematic Editor
File Edit Insert View Analysis BEAE]

@8[] o[& [ =

Function Generator
Multimeter

XY Recorder
Oscilloscope
Signal Analyzer

7 e
i =1 3

os]

L2
-

J+l6]Z[e]%]

Basic Sources

1kHz Wien-bridge Oscillator
Tina-TI simulation circuit

e Oscilloscope - Virtual

Trigger Horizontal
RE 15k 1 2V o] ) Mode Source | Time/Div
—W D2 1N4148 |uto = || [0 2]
Level Position
P D1 1N4148 [ \ \ ; ;J 2 _:_|
wHian Fi} Mode
Y%
4 /41 Storage XY: “‘J
_Run_ | Stop etk
1 V- Store | Erase Ml =
U1 OPA743 ch |
Vertical
3 3.4k — VM1 ~! | Volts/Div
y + Coupling 2 ;]
> v A VM1 XA 635380 XB: llém DX: 51986u ‘—EC_ + | AC Position
Vi 2 47n _L B: VMl YA 460 YB: 469 DY: 938 ID—— ,A_J
,,*_*_1 I - Cursor Data On ___J =
R4 3.4k Alefon 0] 2] | 25 8| A Ao

®

| Adjust the controls as needed. |

Figure 8. Virtual Instrumentation Testing
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6 Additional Assistance

TINA-TI has many more features that can be explored. As you become more comfortable with the
simulation software, you will be able to take advantage of these capabilities to build circuits more rapidly,
perform more sophisticated simulations, and optimize the output information for a variety of needs.

The software also offers on-screen contextual help, and displays mouse-over descriptions for many icons
and areas of the workspace, as shown in Figure 3. If you need additional assistance with a particular
analysis, or help with setting the active component parameters, detailed help documentation is available.
Click on the Help menu to access information associated with circuit analysis, active components, and so
forth. Further assistance for specific TINA-TI application simulations is available by contacting your local TI
technical representative.

Many of Tina’s component and Analysis windows
provide a Help button.

28 Wien_bridge_osc - Schematic Editor
File Edit Insert View ELEMSEN Ta&M  Tools Help
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AC Analysis , Fourier Series
Transient... The frequency domain characteristics of the transient responses can be examined using Fourier
Steady State Solver... obtained by computing the Fourier series of the output function of time, and then calculating the

coefficients. Harmonic distortion is displayed in units of %. After selecting Fourier Series, this

Noise Analysis...

Sampling start time This determines the instant when the Fourier analysis starts. T
TKHZ Wi options... display parameter of the Transient Analysis Menu. You
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A D2 1N4148 he sampling start time and the recipr
S ke st IU— han the Time of analysis paramety
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D1 1N4148 Base frequency 100 b after the initial transient has died aw)

i Num| Yling points for the FFT. Due to the nat
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f Number of harmonics 16 = % Cencel l samples, the greater is the accuracy
v Hopates Num| Fomat [C@espli*(t+f))  ~] urier coefficients (from 2 to 16) have if

f“—“-“——*j' pefficients will be displayed on the sd

,* Form Qutput JvM1 two usual formats for representing th
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V4 C247n _L * Calculate operating point

] ] = Calg] | © Useinitial conditions ate the Fourier series using the para

Ré 3.4k " Zero initial values an extendible table in the dialog box

= VIS e ryou change a parameter on the dial
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Figure 9. Contextual Help in TINA-TI
Note: Texas Instruments does not offer support for TINA software. Contact if you have

questions or need assistance with general TINA software issues.
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI's standard
warranty. Testing and other quality control techniques are used to the extent Tl deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

Tl assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other Tl intellectual property right relating to any combination, machine, or process in which Tl products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from Tl under the patents or other intellectual property of TI.

Reproduction of Tl information in Tl data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. Tl is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.

Resale of Tl products or services with statements different from or beyond the parameters stated by Tl for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. Tl is not
responsible or liable for any such statements.

Tl products are not authorized for use in safety-critical applications (such as life support) where a failure of the Tl product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of Tl products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify Tl and its representatives against any damages arising out of the use of Tl products in
such safety-critical applications.

Tl products are neither designed nor intended for use in military/aerospace applications or environments unless the Tl products are
specifically designated by Tl as military-grade or "enhanced plastic." Only products designated by Tl as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of Tl products which Tl has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

Tl products are neither designed nor intended for use in automotive applications or environments unless the specific Tl products are
designated by Tl as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

Products Applications

Amplifiers Emplifier.i.com Audio [pww Ti.com/audid

Data Converters Fataconverterir.com Automotive [vww Tr.com/automofiv

DSP Esp-ii.con Broadband [pww i.com/broadband

Clocks and Timers [www i-com/clocky Digital Control [pww ir-com/digitalcontrol

Interface [nierface-fi.com Medical [pww Ti.com/medical

Logic [ogicircon Military [vww i-com/militany

Power Mgmt power-i.com Optical Networking [xww Ti.com/opficalnetwor

Microcontrollers Icrocontroller.t.com Security [nww r-com/secur

RFID ‘ Ti-rfid.co Telephony lvww.tr.com/telephony

RF/IF and ZigBee® Solutions [WWw.ir.com/Ipr Video & Imaging vww Tr.com/vided
Wireless [vww T.com/wirelesy

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2008, Texas Instruments Incorporated
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